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Inserting Headers and Footers
1.	 Insert << Header 

 

2.	 Enter Header text

 

3.	 Insert << Footer - enter Footer text

 

Viewing / Editing Header and Footer
Double click on the Header or Footer area to view or edit text.  Press Esc (on your keyboard) 
to return to your document.
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Microsoft Word 2013
Inserting Headers and Footers
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Microsoft Word 2013
Inserting Page Numbers (and formatting them)

www.eit.ac.nz/library/ls_computer_word2013_pagenumbers.html

Inserting Page Numbers (and formatting them)

Insert << Page Number 
 

 
 
Identify where you want your Page Numbers to be positioned (top or bottom of page), 
then select the formatting
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LIBRARY AND LEARNING SERVICES | FORMATTING YOUR DOCUMENT

To edit the numbers – Double click on the Header or Footer area and highlight the number 
you want to edit

 

To format the page numbers - Insert << Page Number << Format Page Numbers

 

Select the formatting you require << click OK to return to your doument.
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LIBRARY AND LEARNING SERVICES | FORMATTING YOUR DOCUMENT

Inserting Page Numbers:  Different on the First Page

This situation will be useful when you do not want a page number on the first page

Page Layout << Page Setup << click the arrow in the bottom right-hand corner

Select the Layout tab << check the Different First Page box in the Headers and Footers 
section << Apply to Whole document (when you have no sections in your document, in 
which case select This section)

 

Inserting Page Numbers:  Different than 1

Insert << Page Number << Format Page Numbers
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Type the Page Number you want to start at.  You may want to use 0 if you set your document 
up with a Different first page.  This way your first page will be 0 and not show and the second 
page will begin at page 1.

 

Inserting Page Numbers:  Different Page Numbers in One Document

You may want to set out an essay with two different number styles.  In academic essays 
Roman numerals start after the title page until the body of the essay begins.  For example 
this may include an abstract, table of contents, executive summary etc ...  Arabic numbers 
start from the main body of the essay.  To achieve this you will need to use Section Breaks in 
your document.  Change the number format in the Page Number Format window.

It is easier to tackle the Page Layout first and create Section Breaks in your document before 
you add the text.

Turn the show/hide button on, this shows parapgraph marks and other hidden formatting 
symbols (they will not show on your printed document), this will show your section breaks 
clearly.
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Microsoft Word 2013
Line Spacing

www.eit.ac.nz/library/ls_computer_word2013_linespacing.html

Line Spacing

Line spacing determines the amount of space between each line space; you can set the 
line spacing before you start to type OR you can highlight selected text and change the line 
spacing. 

 

Home << Line Spacing icon 

This is single line spacing
This is single line spacing
This is single line spacing

This is double (2.0) line spacing

This is double (2.0) line spacing

This is double (2.0) line spacing

This is 1.15 line spacing

This is 1.15 line spacing

This is 1.15 line spacing

This is 2.5 line spacing

This is 2.5 line spacing

This is 2.5 line spacing

This is 1.5 line spacing

This is 1.5 line spacing

This is 1.5 line spacing

This is 3.0 line spacing

This is 3.0 line spacing

This is 3.0 line spacing
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By default, the margins for a Word document are 2.54 cm on the top, bottom, and sides. 

1.	 Page Layout << Margins - select Normal or Custom Margins. 
 

NB: This is useful for changing your margins in your assignment. 
 

Custom Margins 

2.	 If you select Custom Margins, the Page Setup window appears.  Tab (or use the arrow 
keys) between each option and type in your margins.  Click OK to apply the changes.

Want more information?
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Microsoft Word 2013
Margins and Page Orientation
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LIBRARY AND LEARNING SERVICES | FORMATTING YOUR DOCUMENT

Want more information?
974 8000 ext 6045
twist@eit.ac.nz

Most EIT essay Page Layout require a left margin of 4cm, to do this simply enter 4 in Left 
Margin << click OK

 

Page Orientation

1.	 Page Layout << select Orientation.

2.	 Choose Portrait or Landscape
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LIBRARY AND LEARNING SERVICES | FORMATTING YOUR DOCUMENT

Want more information?
974 8000 ext 6045
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NB: To have pages of portrait and landscape orientation in a single document, use section 
breaks between the affected pages.  To do this:- 

1.	 Go to the page you want to change the orientation of, select the area before the text on 
the page you want to change.  Page Layout << Breaks << Section Break << Next 
Page

2.	 Select the area after the text on the same page, Page Layout << Breaks << Next 
Page

3.	 The document is now comprised of three sections.  Select an area in the page you want to 
change the orientation of.  Page Layout << Orientation << Portrait OR Landscape
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Want more information?
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LIBRARY AND LEARNING SERVICES | FORMATTING YOUR DOCUMENT
www.eit.ac.nz/library/ls_guides_word2013_computer_pagebreaks.html

Microsoft Word 2013
Inserting Page Breaks and Section Breaks
Page Breaks and Section Breaks

Page Break:  Separates content between pages
Section Break:  Used to create layout or formatting changes in a portion of a document.

Inserting a Page Break 

1.	 Click in your document where you want to start a new page, Insert << Page Break

Inserting a Section Break

1.	 Click where you want to change the format, Page Layout << Breaks

2.	 Choose which type of Break you want for your document
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Want more information?
974 8000 ext 6045
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           LIBRARY AND LEARNING SERVICES | FORMATTING YOUR TEXT
www.eit.ac.nz/library/ls_computer_word2013_aligning.html

Microsoft Word 2013
Aligning Text
Align text:

1.	 The text alignment in Microsoft Word documents is pre-set to left alignment.
2.	 To change the alignment select the text (sentence, paragraph, section) you want to 

change.

NB: To select the entire document use the Shortcut Key << CTRL+A

3.	 The alignment icons are on the ribbon of the Home tab

4.	 There are four different types of alignment;

Left

Left aligned text
Left aligned text
Left aligned text
Left aligned text
Left aligned text
Left aligned text
Left aligned text

Center

Center aligned text
Center aligned text
Center aligned text
Center aligned text
Center aligned text
Center aligned text
Center aligned text
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LIBRARY AND LEARNING SERVICES | FORMATTING YOUR TEXT

Want more information?
974 8000 ext 6045
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Right

Right aligned text
Right aligned text
Right aligned text
Right aligned text
Right aligned text
Right aligned text
Right aligned text

Justify

Justify aligned text, Justify aligned text, 
Justify aligned text, Justify aligned text, 
Justify aligned text, Justify aligned text, 
Justify aligned text, Justify aligned text, 
Justify aligned text, Justify aligned text, 
Justify aligned text, Justify aligned text, 
Justify aligned text, Justify aligned text,  
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           LIBRARY AND LEARNING SERVICES | FORMATTING YOUR TEXT
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Microsoft Word 2013
Bullets and Numbering
Bullets and Numbering

Bullets and numbering are used to emphasise lists of things and usually make lists easier to 
read and follow.

How to apply bullets while you type:

Click on Bullets icon << Type your text << Enter
OR
Select text you want as a bulleted list << click on the Bullets icon

Example:  Bullet List
Agenda

•	 Karakia
•	 Mihi
•	 Review Policies
•	 Chairperson Report
•	 Treasurer Report
•	 Other Business

Bullets:  Change Formatting

Select text << Click on triangle to right of Bullet icon << Select from Bullet Library or 
Define New Bullet

Example:  Bullet List
Agenda
◊	 Karakia
◊	 Mihi
◊	 Review Policies
◊	 Chairperson Report
◊	 Treasurer Report
◊	 Other Business
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LIBRARY AND LEARNING SERVICES | FORMATTING YOUR TEXT

Want more information?
974 8000 ext 6045
twist@eit.ac.nz

How to apply numbers while you type:

Click on Numbering icon << Type your text << Enter
OR
Select text you want as a numbered list << click on the Numbering icon

Example:  Numbered List
Agenda

1.	 Karakia
2.	 Mihi
3.	 Review Policies
4.	 Chairperson Report
5.	 Treasurer Report
6.	 Other Business

Numbering:  Change Formatting

Select text << Click on triangle to right of Numbering icon << Select from Numbering 
Library or Define New Number Format

Example:  Numbered List
Agenda

I.	 Karakia
II.	Mihi
III.	Review Policies
IV.	Chairperson Report
V.	 Treasurer Report
VI.	Other Business
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LIBRARY AND LEARNING SERVICES | FORMATTING YOUR TEXT

Want more information?
974 8000 ext 6045
twist@eit.ac.nz

Outline Numbering:

This is mainly used in a large-scale report where you require Headings and sub headings to 
be numbered.

Highlight text << click on Outline Numbering << select list type (click on triangle to right 
of Outline Numbering icon) << enter

Your document will be numbered from one to fifteen as in the example below; increasing the 
indent by one or two levels will change the list level as displayed in the following examples.
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Want more information?
974 8000 ext 6045
twist@eit.ac.nz

           LIBRARY AND LEARNING SERVICES | FORMATTING YOUR TEXT
www.eit.ac.nz/library/ls_computer_word2013_formatpainter.html

Microsoft Word 2013
Format Painter
Format Painter:

This is used to copy formatting from one part of your document and apply it to another part 
of your document.

 

 

1.	 Highlight the formatting you want to use in another part of your document.
2.	 Click on the Format Painter icon.
3.	 Highlight the text you want to change and it will change to the copied format.

NB:  Double click the Format Painter icon - it will stay highlighted. This allows you to 
apply the same formatting to multiple places in your document.
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Want more information?
974 8000 ext 6045
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           LIBRARY AND LEARNING SERVICES | FORMATTING YOUR TEXT
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Microsoft Word 2013
Hanging Indent
Hanging Indent:

1.	 Select the text
2.	 Home << Paragraph 

 

3.	 Select Hanging from the Special drop-down list in the Indents and Spacing tab << 
OK

Example:

Morreale, S., Spitzberg, B.H., & Barge, J. K.  (2007). Human communication:  Motivation, 		
	 knowledge and skills (2nd ed.).  Belmont, CA:  Thomson Wadsworth.

NB: This is useful when adding references for your assignments, however if you have a large 
list it is recommended that you use the EndNote software provided for you by EIT (available 
from the Library)
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Want more information?
974 8000 ext 6045
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           LIBRARY AND LEARNING SERVICES | FORMATTING YOUR TEXT
www.eit.ac.nz/library/ls_computer_word2013_superscript.html

Microsoft Word 2013
Superscript -”...to the power of...” or exponential notation

Superscript -”...to the power of...” or exponential notation

You may need to create superscript characters within your assignments and formulas.  
Superscript sits just above the center line.

Highlight the number/s
(Hold down the Ctrl key and double click on the numbers if you want to change multiple 
numbers)

Home << Superscript
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Count the Words as you type
When you type in a document, Word automatically counts the number of pages and words in 
your document and displays them on the status bar at the bottom of your Word document.

NB:  Sometimes the status bar doesn’t appear, if this occurs, right click on the status bar << 
select Word Count

Want more information?
974 8000 ext 6045
twist@eit.ac.nz

LIBRARY AND LEARNING SERVICES | REVIEW YOUR DOCUMENT
www.eit.ac.nz/library/ls_computer_word2013_wordcount.html

Microsoft Word 2013
Word Count

Counting the number of words in your document

Microsoft Word can count the number of words in your document while you type 
and can also count the following;

•	 Pages

•	 Paragraphs

•	 Lines

•	 Characters, including or excluding the spaces
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LIBRARY AND LEARNING SERVICES | REVIEW YOUR DOCUMENT

Want more information?
974 8000 ext 6045
twist@eit.ac.nz

Count the Words in a sentence or paragraph
You can count the number of words in selected text rather than all of the words in your 
document.

1.	 Simply select the text with your mouse that you want to count. 

2.	 The status bar shows you the number of words in the selection. 

 

53 of 2944 words means that the selected text accounts for 53 words out of a total number of 
words in your document, 2944.

NB:  If you have multiple paragraphs within your document you want to count, hold the CTRL 
key down on the keyboard and select these parapgraphs using your mouse. This will show 
you the word count for only those selected paragraphs.
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Want more information?
974 8000 ext 6045
twist@eit.ac.nz

LIBRARY AND LEARNING SERVICES | REVIEW YOUR DOCUMENT
www.eit.ac.nz/library/ls_computer_word2013_spellcheck.html

Microsoft Word 2013
Spell Check
Spell Checking your document

1.	 Click on the Review tab << then Proofing << click Spelling & Grammar
 

 
Spelling & Grammar will go through the whole of your document and check each word for 
you. 
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LIBRARY AND LEARNING SERVICES | REVIEW YOUR DOCUMENT

Want more information?
974 8000 ext 6045
twist@eit.ac.nz

If a spelling mistake is found, the following panel will appear to the right of your document;
 

As you can see there are multiple options to deal with the suggestions that Word has given 
you, normally the correct spelling is the first suggstion shown and you can click on the 
Change button to correct your misspelling. 

Automatic Spell Check from Home

This is where Word automatically checks your spelling as you type; there are some options 
you need to check.

Click on the File tab on the Ribbon << Select Options
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LIBRARY AND LEARNING SERVICES | REVIEW YOUR DOCUMENT

Want more information?
974 8000 ext 6045
twist@eit.ac.nz

Select Proofing << tick Check spelling as you type

 

 

 

A spelling mistake usually occurs with a red squiggley line underneath, as shown below;
 

 
To correct the mistake:

Right click on the word and the following dialogue box will appear << Select the correct 
spelling
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Want more information?
974 8000 ext 6045
twist@eit.ac.nz

LIBRARY AND LEARNING SERVICES | REVIEW YOUR DOCUMENT
www.eit.ac.nz/library/ls_computer_word2013_thesaurus.html

Microsoft Word 2013
Thesaurus
The thesaurus enables you to look up synonyms (these are different words with the same 
meaning), and autonyms are words with the opposite meaning.

1.	 Click on the Review tab in the Proofing group << Thesaurus

 
Example using the Thesaurus:
To change the sentence below, I chose the words a lot to something more appropriate;

Today a lot of great things happened, on this day in 1845 - German composer

Felix Mendelssohn’s Violin Concerto, one of the most popular and most frequently

performed violin concertos of all time, and was first played in Leipzig.

2.	 Right click on the word and the following box will appear << Select a word. 
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3.	 Select Thesaurus at the bottom of the box << a list of words will appear to the right of 
your screen.

 

 

Want more information?
974 8000 ext 6045
twist@eit.ac.nz

LIBRARY AND LEARNING SERVICES | REVIEW YOUR DOCUMENT
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Want more information?
974 8000 ext 6045
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4.	 To insert the new wording you want to use << Click on down arrow << Choose Insert and 
the new wording will be inserted over the original word.

 

LIBRARY AND LEARNING SERVICES | REVIEW YOUR DOCUMENT
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Inserting images:  From your computer 

Use these instructions if you have an image or photo you have saved previously and want to 
use it in your document. 

1.	 Place your cursor where you want to insert your image. 

 
 

2.	 Insert << Picture 

 
 

3.	 Browse to where your image is saved << select image file << Insert

Want more information?
974 8000 ext 6045
twist@eit.ac.nz

LIBRARY AND LEARNING SERVICES | WORKING WITH IMAGES
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Microsoft Word 2013
Inserting images:  From your computer
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Please Note: 
Check the copyright permission for images you wish to use. All images used must be 
referenced according to the APA referencing style.  Please refer to How do I reference a 
figure from a website?  or go to the APA Referencing – Instruction Manual for citation 
and reference instructions.

Inserting images:  From the internet

Select the image << right click Copy image

Go back to your document << right click Paste

Want more information?
974 8000 ext 6045
twist@eit.ac.nz

LIBRARY AND LEARNING SERVICES | WORKING WITH IMAGES
www.eit.ac.nz/library/ls_computer_word2013_imageinternet.html

Microsoft Word 2013
Inserting images:  From the Internet
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Want more information?
974 8000 ext 6045
twist@eit.ac.nz

LIBRARY AND LEARNING SERVICES | WORKING WITH IMAGES

To save the image to your computer << right click on the image << Save image as...

Save the image to your H: Drive << My Pictures folder << Open

Name the file << Save

Reference
lozikiki. (2011). Frangipani [Photograph]. Retrieved from http://loziki.deviantart.com/art/
	 Frangipani-244133317
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Want more information?
974 8000 ext 6045
twist@eit.ac.nz

LIBRARY AND LEARNING SERVICES | WORKING WITH IMAGES
www.eit.ac.nz/library/ls_computer_word2013_imageclipart.html

Microsoft Word 2013
Inserting images:  From Clip Art
Inserting Images from Clip Art:

Place your cursor where you want to insert a clip art image << Insert << Online Pictures

The Insert Pictures box appears as shown below;

Enter a keyword into the Bing Image Search box e.g. Grapes << Press Enter or Click on the 
Search button
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Want more information?
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LIBRARY AND LEARNING SERVICES | WORKING WITH IMAGES

Select the image you want to use << Insert
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1.	 To capture the entire screen click anywhere at once

2.	 Press the Print Screen (PrntScn) key << Paste (Ctrl + V) into your document

1.	 To capture a window (not the entire screen), e.g. an error message or dialogue box

2.	 Choose Insert << Screenshot 

Want more information?
974 8000 ext 6045
twist@eit.ac.nz

LIBRARY AND LEARNING SERVICES | WORKING WITH IMAGES
www.eit.ac.nz/library/ls_computer_word2013_screenshots.html

Microsoft Word 2013
Capturing Screen Snapshots
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LIBRARY AND LEARNING SERVICES | WORKING WITH IMAGES

Want more information?
974 8000 ext 6045
twist@eit.ac.nz

NB:  The PrtScn key can be in different places depending on the type of keyboard, usually it 
is located above the Insert key
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When you have selected an image in your document a new tab appears on the ribbon.  
Picture Tools << Format

Right clicking on the image will give you a quick list of formatting options as well.

NB:  If you only require a portion of the image you have copied, use the cropping tool to crop 
out the parts you don’t need. 

Want more information?
974 8000 ext 6045
twist@eit.ac.nz

LIBRARY AND LEARNING SERVICES | WORKING WITH IMAGES
www.eit.ac.nz/library/ls_computer_word2013_formattingimages.html

Microsoft Word 2013
Formatting your images
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Inserting a table
Insert << Table 

Want more information?
974 8000 ext 6045
twist@eit.ac.nz

LIBRARY AND LEARNING SERVICES | WORKING WITH TABLES
www.eit.ac.nz/library/ls_computer_word2013_tables.html

Microsoft Word 2013
Working with tables

What is a table?

A table is information arranged in horizontal rows and vertical columns. You can use a 
table to organise text or numerical data. You can format text in various ways in different 
parts of a table.

When you first insert a table into a document, it appears as a simple grid, with black 
gridlines defining the rows and colums. The area where a row and column meet is called 
a cell.
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LIBRARY AND LEARNING SERVICES | WORKING WITH TABLES

Position the mouse pointer in the upper-left cell of the grid, then drag the pointer down and 
across the grid until you have highlighted the amount you require. For this exercise we will 
create two columns and five rows – the outline of a cell turns orange when you highlight it. 
NB: You are able to add or delete rows and columns at a later stage if needed.

When you have the table size correct - 2 x 5, an empty table, two columns by five rows, 
appears, with the insertion point in the upper-left cell.

Example

When you are working in the table or the table is selected two new tabs appear on the ribbon, 
Design and Layout.
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LIBRARY AND LEARNING SERVICES | WORKING WITH TABLES

Entering Data in a Table
You can enter data in a table by moving the insertion point to a cell and typing. If the data 
takes up more than one line in the cell the text will automatically wrap to the next line. 
This increases the height of that cell and all the other cells in that row. To move to the next 
insertion point, you can press the Tab key on the keyboard or simply click on the desired cell.

Example

Item Materials Cost
Weather stripping $350.00
High efficiency water heaters $8,500.00
High efficiency furnaces $10,000.00
Insulation $700.00

This is what selected text looks like, to select the whole table use the Table move handle.

To select a row or column
Move the mouse pointer to the left of the table next to the row or column. The pointer 
changes to a right-facing arrow for a row, or a downward facing arrow for a column. Click the 
left mouse button. The entire row or column is selected.

Example: entire header row selected.
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To format the text you can switch to the:

1.	 Home tab 

2.	 Use the Mini toolbar 

3.	 Or use keyboard shortcuts. (See Keyboard shortcuts)

LIBRARY AND LEARNING SERVICES | WORKING WITH TABLES
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Sorting Information in a table
The term sort refers to the process of rearranging information in alphabetical, numerical or 
chronological order.

Select the whole table

 

1.	 Layout << Sort

By default the table will be sorted by item, the type will be text, and it will be in ascending 
order.

Example: Unsorted Data

Item Materials Cost
Weather Stripping $350.00
High efficiency water heaters $8,500.00
High efficiency furnaces $10,000.00
Insulation $700.00

LIBRARY AND LEARNING SERVICES | WORKING WITH TABLES
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Example: Sorted Data on ITEM content << Ascending

Item Materials Cost
High efficiency furnaces $10,000.00
High efficiency water heaters $8,500.00
Insulation $700.00
Weather Stripping $350.00

Example: Sorted Data on MATERIAL COST content << Descending

Item Materials Cost
High efficiency furnaces $10,000.00
High efficiency water heaters $8,500.00
Insulation $700.00
Weather Stripping $350.00

LIBRARY AND LEARNING SERVICES | WORKING WITH TABLESLIBRARY AND LEARNING SERVICES | WORKING WITH TABLES
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Inserting Rows and Columns in a table

You will often need to modify a table by adding or deleting rows and columns.

Inserting a column:

1.	 Click any cell in the Item column

Item Materials Cost
Weather Stripping $350.00
High efficiency water heaters $8,500.00
High efficiency furnaces $10,000.00
Insulation $700.00

2.	 Layout << Select << Select Column

3.	 Rows and Columns Group << Insert Right

A new, blank column is inserted to the right of the item column as shown below;

Item Materials Cost
Weather stripping $350.00
High efficiency water heaters $8,500.00
High efficiency furnaces $10,000.00
Insulation $700.00

LIBRARY AND LEARNING SERVICES | WORKING WITH TABLES
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4.	 Click in the top cell of the new column, and enter your new data, Use the arrow key to 
move the insertion point down through the column. 

Item Labour Cost Materials Cost
Weather stripping $3,000.00 to $4,500.00 $350.00
High efficiency water heaters $2,000.00 to $3,000.00 $8,500.00
High efficiency furnaces $1,000.00 $10,000.00
Insulation $1,500.00 $700.00

Inserting a row:
This is similar to inserting a column.

1.	 Select a row below the location where you want to insert a row.

2.	 In the Rows and Columns group << Insert Rows Above 

 
 

3.	 To insert a row below select the Insert Below icon.  Keyboard shortcut: click at the end 
of a row in the table where you want a row inserted and press enter.
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Deleting rows and columns in a table
Before you delete a row, you need to work out whether you want to delete the contents of the 
row, or the contents and the structure of the row. You can delete the contents of the row by 
selecting the row and pressing the Delete key.

1.	 Select the row you are going to delete. 

 

1.	 Layout << Delete << Delete Rows 

 

2.	 Select the column you are going to delete

 

3.	 Layout << Delete << Delete Columns

LIBRARY AND LEARNING SERVICES | WORKING WITH TABLES
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Formatting your table with styles:
1.	 Click in the table you want to format. 

 

2.	 Click Table Tools << Design 

 

3.	 In the Table Styles Group, select the downward facing arrow highlighted below to 
display the Table Styles gallery.  In the gallery click on the style you want to use for your 
table. 

 

4.	 Position your mouse over a style to see a live preview of the style in your document

LIBRARY AND LEARNING SERVICES | WORKING WITH TABLES
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Creating a Table of Contents
The easiest way to create a table of contents is to use the built-in heading styles for headings 
throughout your document.

References tab << Table of Contents 
 
 

Click the arrow in the right hand bottom corner of Table of Contents, as shown below.  This 
will give you a list of Built-in Automatic Tables.

 
 

Want more information?
974 8000 ext 6045
twist@eit.ac.nz

LIBRARY AND LEARNING SERVICES | TABLE OF CONTENTS 
www.eit.ac.nz/library/ls_computer_word2013_toc.html

Microsoft Word 2013
Table of Contents
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LIBRARY AND LEARNING SERVICES | TABLE OF CONTENTS

Once you have made your selection, click on Automatic Table 1 or 2, this will automatically 
insert your Table of Contents based on your selection.

To make formatting changes to your Table of Contents << Select Custom Table of Contents
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Once you have selected the Custom Table of Contents, the following dialogue box will appear 
and you can make any formatting changes here.

To change the Tab leader << select the box shown below;

LIBRARY AND LEARNING SERVICES | TABLE OF CONTENTS
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You can also increase or decrease the levels of the headings, as shown below;

Updating a Table of Contents

If you make changes to your document that changes the Page Numbers or Headings you will 
need to update your Table of Contents.

Select the Table of Contents and at the top you will get an Update Table menu.  Select Update 
entire table and the changes will be made.

LIBRARY AND LEARNING SERVICES | TABLE OF CONTENTS

Want more information?
974 8000 ext 6045
twist@eit.ac.nz
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Want more information?
974 8000 ext 6045
twist@eit.ac.nz

LIBRARY AND LEARNING SERVICES | SAVING @ EIT
www.eit.ac.nz/library/ls_computer_word2013_saving.html

Microsoft Word 2013
Saving @ EIT

Saving your Document

It is good practice to save your document before you start working on it, and to save 
periodically as you continue to add to it, to minimise work lost if something goes wrong. 
Where you save your document depends on where you are working on it.

Personal Computer at home:	“My Documents” on the C: Drive

EIT:					     H: Drive (never save to the desktop as this is reset 		
					     everytime the computer is restarted)

Home & EIT:			   USB Memory Stick

NB. As a precautionary measure it is also good practice to email your document to yourself 
so there is always a retrievable copy if there are problems with the other copies.

Saving a New Document to your H: Drive

The first time you save a new document at EIT you need to select where to save it. This will 
always happen when you are working on new documents.

Click on Save >> the following screen will appear
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LIBRARY AND LEARNING SERVICES | SAVING @ EIT

Want more information?
974 8000 ext 6045
twist@eit.ac.nz

Click on the Browse button  >> the following screen will appear;

You need to select your H: Drive

Before you save your work, create a New Folder to keep your H: Drive tidy.
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LIBRARY AND LEARNING SERVICES | SAVING @ EIT

Want more information?
974 8000 ext 6045
twist@eit.ac.nz

Click on the New Folder icon and the following will appear in your H: Drive;

Give your New Folder a relevant name e.g. ITHD6.240, see below;

Press Enter >> Click to Open

Create a name for your file

Click Save.

NB:  If you are at home or are using a USB to save a new document, make sure it is saving 
to the right location as mentioned above.
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Want more information?
974 8000 ext 6045
twist@eit.ac.nz

LIBRARY AND LEARNING SERVICES | SAVING @ EIT

Opening and saving an edited document

Browse to the location of your document and open your document. It will open up in Word 
automatically.

Once you have finished making your changes to your document >> click on the Save icon at 
the top of the ribbon.

If the save icon is not showing at the top of your document, you need to add it to the Quick 
Access Toolbar.

To add a button to the Quick Access Toolbar, you need to Customise the Quick Access 
Toolbar by clicking on the down arrow, shown below.

Select Save and the Save icon  will be added to your Toolbar. This will update your 
documents and save where you opened your document from.
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Want more information?
974 8000 ext 6045
twist@eit.ac.nz

LIBRARY AND LEARNING SERVICES | SAVING TO A USB MEMORY STICK
www.eit.ac.nz/library/ls_computer_word2013_savingusb.html

Microsoft Word 2013
Saving to a USB Memory Stick

	 These little devices are great for creating a backup of your work, which you
	 should have just in case something goes wrong and you lose your work on the
	 computer
	 As we have already saved our document using the saving techniques above, we
	 are now going to save using the Save As facility on the keyboard.
	 Make sure your USB is plugged into a USB port at the front of the computer.
	 With your document still open >> press the F12 key on the keyboard and the
	 following screen will appear;

Saving to a USB Memory Stick

These little devices are great for creating a backup of your work, which you should have just 
in case something goes wrong and you lose your work on the computer.

As we have already saved our document using the saving techniques above, we are now 
going to save using the Save As facility on the keyboard.

Make sure your USB is plugged into a USB port at the front of the computer.

With your document still open >> press the F12 key on the keyboard and the following 
screen will appear;
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LIBRARY AND LEARNING SERVICES | SAVING TO A USB MEMORY STICK

Want more information?
974 8000 ext 6045
twist@eit.ac.nz

This time we need to select the USB (D: Drive), as shown below;

It should be empty the first time you use it

Click on Save;
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LIBRARY AND LEARNING SERVICES | SAVING TO A USB MEMORY STICK

Want more information?
974 8000 ext 6045
twist@eit.ac.nz

Your document should be saved to your USB.

Once you have finished saving your documents you will need to safely remove the USB so 
that the work saved to it will not be lost.

Close all open documents that you have been working on.

Click on the device with a tick symbol at the bottom right of your screen.

Click on Eject USB (the name of your USB)

A message will appear telling you, you can safely remove your USB. Remove the USB from 
the front of the computer.
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